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1 Overview 

1.1 General Overview 

Functions of the User Interface: 

The MDA Alarm and Message Evaluations user interface provides the following functions: 
• Current alarms for individual machines or machine groups 

You can display and analyze the current non-reset alarms and messages for individual machines 
or defined machine groups. 

• Alarm log for individual machines or machine groups 
You can display and analyze the current non-reset alarms and messages for individual machines 
or defined machine groups. 

• Alarm statistics for individual machines or machine groups 
You can display and analyze statistics for alarms and messages for individual machines or defined 
machine groups. 

• Evaluation groups 
You can summarize machines and units in analysis groups. These evaluation groups are used 
when analyzing �machine groups�. 

• Alarm filters 
You can define analysis filters for the display of alarm logs and alarm statistics. 

 

This user guide provides an overview of the individual alarm and message diagnosis functions.  
 
 
Authorization Groups: 
Depending on the user group, you can also deactivate individual functions. 

 

All screen form and function descriptions assume that the default configuration has been installed on a 
PC with Windows NT 4.0 and display the functions configured at delivery. 
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1.2 Definition of Machines and Units 

Machines and units are defined using the customizing facility. 

A machine is classified in MDA using the following information: 
• PLANT 

The four-digit �PLANT� code is used to classify machines that are all in the same plant or building. 
• MACHINE 

Machines can consist of several units. One of the units in the machine is defined as the �Main 
Unit�. 

• UNIT 
As well as the main unit, each machine can have several other units representing parts of the 
machine such as a feeder, a grinding spindle etc. 

 

Each machine and each unit can send an alarm notification. 
 

 
1.3 Definition of Alarms 

Alarms can be classified by: 
• Alarm group 

Alarms from the same types of machine are summarized into alarm groups.  
• Alarm source 

This identifier indicates what subsystem sent the alarm (i.e. MMC, ProAgent/Pro, ...) 
• Alarm number 

A unique alarm number for each alarm group and alarm source 

All alarms have a an alarm text description in several languages. 
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1.4 Operator Inputs to Screen Forms 

You can make inputs to the user interface screen forms using the mouse or just the keyboard. 
 

Name of the Current Screen Form: 
On Windows PCs, the system enters the name of the current screen form in the window's header. 

 

Keyboard inputs: 
  

Key Effect 

TAB Moves to the next field in the screen form, including the pushbuttons in 
the footer 

HOME Moves to the next field in the screen form, but not to the pushbuttons in 
the footer 

TOGGLE Press the toggle key to select/deselect rows. 
The toggle key is in the middle of the block of the numeric keypad (�5�) 

  

 

Date and Time Inputs: 
Entering dates and times is very convenient: 

Entering a date can be done in the following ways: 
• Entry in the locale-specific format, for example:   �28.2.2000� or �2000-2-28� 

In this case the sequence of day, month, year and the separator must be entered exactly the way 
the date is output by the program.  
You use the format which was specified for the �DAYFORMAT� key in the screen form texts of the 
active language during configuration. 

• Short format:   �280200� or  �28082000� 
The day, month and year are entered without separators.  
The day and month must be entered in two-digit notation and the year can be two or four digits 
long. 
The first two digits are interpreted as the day, the next two as the month and the remaining digits 
as the year. 
Two-digit year notation is interpreted as follows: 
   00 .. 90 >  2000 .. 2090 
   91 .. 99 >  1991 .. 1999 

• Scrolling with the arrow keys: 
You can move one day forward / backward by pressing the ARROW UP or ARROW DOWN keys. 
You can move one month forward / backward by pressing the Shift + ARROW UP or Shift + 
ARROW DOWN keys. 

• If a date is entered in �From Time� which comes before the first available record, then �From Time� 
defaults to the date of the first record. 
 

You can enter a time range in the alarm log as described above. The time types in the alarm statistics are 
�Shift�, �Day�, �Week�, �Month� and �Year�. 

Special rules apply to the time types  �Week�, �Month� and �Year�: 
• �Week�:  
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- When you enter a day in the �From� field, the first day of the week for the day entered is 
automatically entered when exiting the field. 
- When you enter a day in the �To� field, the last day of the week for the day entered is 
automatically entered when exiting the field. 
- When you press the ARROW UP or ARROW DOWN key to scroll while the �From� field is active, 
each time the date shifts by one week, the �To� field changes its entry to the last day of that week. 
- When you press the Arrow Up or Arrow Down key to scroll while the �To� field is active, shifting 
the date by one week will not change the entry in the �From� field  

• �Month�: 
Possible month field inputs for �January 2000�: 
   �01.00�     �01.2000�    �0100�   �012000�  
Using the arrow keys, you can scroll backwards and forwards by one month.  
When scrolling in the �From� field, the �To� field displays the same month. 
When scrolling in the �To� field, the �From� field remains unchanged. 

• �Year�: 
Possible year field inputs for �2000�: 
   �00�     �2000�  
Using the arrow keys, you can scroll backwards and forwards by one year.  
When scrolling in the �From� field, the �To� field displays the same year. 
When scrolling in the �To� field, the �From� field remains unchanged. 
 

Entering a time can be done in the following ways: 
• Entries with the �HH:MM� format, for example:    

Short entries are automatically converted: 
   �7:2� >  �07:02� 
    �5� >  �05:00� 
    �18� >  �18:00� 
    �:4� >  �00:04� 

• Entries without separators, for example:  �855�, �1205� 
If only one or two digits are entered, the number is interpreted as an hour. 
If only three or four digits are entered, the last two digits are interpreted as minutes and the 
previous digits as hours. 
   �855� >  �08:55� 
   �1205� >  �12:05� 
   �120� >  �01:20� 
   �12� >  �12:00� 
   �1� >  �01:00� 

• Scrolling with the arrow keys: 
You can move one hour forward / backward by pressing the ARROW UP or ARROW DOWN keys. 
You can move one minute forward / backward by pressing the Shift + ARROW UP or Shift + 
ARROW DOWN keys. 
 

If the �Shift� time type is selected, you can select the shift number in the �Time� fields.  Pressing the arrow 
keys changes the respective shift number. 

Additionally, the time range set for one evaluation is automatically transferred to the other evaluations. 
 

Zooming the Screen Forms: 
On Windows PCs, you can resize the screen forms. The system adjusts the graphics, tables and lists to 
the current size of the screen form. 
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1.5 Printing Tables / Exporting Data to Excel 

The user interface provides two printing modes: 
• Simple printout: 

Simple hardcopy of current screen 
• Extended printout: 

Printout of hardcopy, data in tabular format and export of screen data to Excel 

It is possible to switch between the two modes by configuring the general parameters ( Customizing 
(User) > General parameters > ALARM_GUI > PRINT_FLAG ): 

• Parameter value = 0 - Simple printout 

• Parameter value = 1 - Extended printout 

Simple Printout �Hardcopy from Screen�: 
If the printout is started here, a hardcopy of the current screen is sent to the computer�s default printer in 
the form of a diagram. 

 

Extended Printout �Print as table� / �Create export file for EXCEL�: 
When the extended printout is selected a dialog box is first displayed. 

 

 
 

There are three ways to print out from the system. 
• Hardcopy (screen shot): 

A printout is generated containing the exact contents of the current screen form. List entries not 
visible in the current screen form will not be visible in the printout either. 

• Tabular printout (List printout): 
The complete contents of the table currently displayed on the screen form are printed out as a list. 
That portion of the list not visible on the screen is also printed out. 

• Exporting data to Excel:  
The data of most screen forms can be exported to a file: The data is stored as a �csv� file and can 
be written directly to Excel from this format. 

   
  ©  Siemens AG 2000-2003 All Rights Reserved 1-5 



Alarm and Message Evaluations MDA Machine/Cell/Plant 

 

    
 1-6 ©  Siemens AG 2000-2003 All Rights Reserved 



MDA Machine/Cell/Plant Alarm and Message Evaluations 

2 General Information on Using the Program 

2.1 Information on Using the Mouse 

All the information on using the right and left mouse buttons refers to the standard mouse settings for 
right-handed people that are made in the Windows control panel. If your Control Panel settings for the 
mouse buttons are for a left-handed person, you should bear this in mind when making the described 
inputs. 

 

 
 
2.2 The Help System 

In the MDA applications, you have a help system available that you can use at any point while working 
with the programs. To call the help system, simply press the F1 function key on the top row of the 
keyboard. 
The help system is context-sensitive, i.e. you are always provided with help that is relevant to the screen 
form in which you are currently working. When you press the F1 function key to start the help system, it 
always provides an explanation to the screen form where you are located at the time. 
Single-clicking terms that are highlighted in green takes you to the desired topic; single-clicking the Back 
pushbutton takes you back to the topic that was displayed previously. The Back pushbutton is located at 
the top of the window under the menu bar. 
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3 Functionality of the User Interfaces 

3.1 Starting the User Interface 

The user interface can be started as follows: 

! Click on the �Start� button in the taskbar and then select �Programs > MDA > Alarms and  
Messages� from the menu. 

 

After starting the user interface, the system displays the login screen. When you enter a valid user name 
and password, the system displays the screen form defined as the main screen during configuration. 

If you specified at configuration that the system is to start without a login screen, the user name that you 
entered during configuration is used and the system immediately displays the main screen configured. 

Depending on the configuration, the user interface will appear either with a toolbar or with function keys in 
the footer and on the right-hand edge. 

At delivery the main screen is configured as the start screen: 

 
 
You can use the menu bar, the pushbuttons in the toolbar or footer to select screen forms for display. 

The functions that you have available depend on the configured user group. 

The message line at the bottom edge of the screen form shows hints and messages. 
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3.2 Menu Bar 

The program functions can be executed both by clicking the pushbuttons in the toolbar or footer or by using the 
menu bar. 

You can switch to any other screen form while one screen form is displayed. The functions visible in the menu 
depend on the authorization group currently active and the configuration of the menu bar. 
Structure of the menu if all the functions are available: 

• File 
- Login screen Displays the login screen to log in again 
- Print ... Displays print dialog 
- End Exits from the user interface 
  

• Evaluations 
- Current alarms Displays current non-reset alarms of a machine 
- Alarm log Displays the alarm log for a machine 
- Alarm statistics Displays the alarm statistics for a machine 
  
- Current alarms for evaluation groups Current non-reset alarms of an evaluation group 
- Alarm log for evaluation groups Displays alarm log for evaluation groups 
- Alarm statistics of evaluation groups  Displays alarm statistics for evaluation groups 
- Evaluation groups  Definition of evaluation groups 
  
- Alarm filters Creates and displays evaluation filters 
  

• Options 
- Language: German / English / ... Switches languages 
  

• Help 
- Table of contents Displays the online help 
- About Displays the version number of the user interface 
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3.3 Buttons in the Tool bar 

You will find small pushbutton icons in the upper section of the screen forms directly below the menu bar. 
The individual pushbuttons are more closely described by a pop-up tool tip text as soon as the mouse 
pointer pauses over the pushbutton. The tool tip shows you the actions that are triggered by the individual 
pushbuttons. 

 

Operating the Pushbuttons: 
You can also use the mouse to operate the pushbuttons. 

 

Appearance and Labeling of the Pushbuttons: 
The pushbuttons are displayed using icons. Modifying the configuration allows a different icon to be 
displayed  

 

Configuring the Pushbuttons in Screen Forms: 
Every screen form has specific functions for the pushbuttons that must be available, e.g. the �OK� function 
to display values. It is possible to configure which pushbuttons and functions are available in each screen 
form. 

 

The following list contains all the available functions with the supplied icons. You can overwrite the icons with 
plant-specific ones. 
 
   

Icon Label Function 

 OK Fills the current screen form with data. 
Saves changes. 

 Discard changes Discards changes and displays the screen with 
the original data. 

 Main 
Screen 

Returns you to the main screen. 
 

 Back one 
Screen 

Returns you to the previously displayed screen. 

 Delete filter section Deletes filter section in the current evaluation filter 

 Delete filter Deletes the current evaluation filter 

 Evaluation 
group 

Definition of evaluation groups 

 Print screen form Displays print dialog 

 Current alarms Displays the current alarms screen 

  Log Screen for displaying alarm logs for individual 
machines 

  Statistics Screen for displaying alarm statistics for individual 
machines 

 Current alarms 
eval. grp. 

Screen displays the current alarms of an 
evaluation group 
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 Log 
eval. grp. 

Screen for displaying alarm logs for individual 
machines 

 Statistics 
eval. grp. 

Screen for displaying alarm statistics for individual 
machines 

 Alarm filter 
definitions 

Screen for creating and displaying evaluation 
filters 

 Login Displays login screen to switch user authorization 

 Help texts Displays the online help 
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3.4 Pushbuttons in the Footer 

It is possible to configure the user interface so that pushbuttons are displayed in the footer and on the 
right-hand edge. 

 

Operating the Pushbuttons: 
• You can also use the mouse to operate the pushbuttons. 

• A function key is assigned to each pushbutton. Pressing the function key triggers the operation. 
In additional screen forms (i.e.: Definition of evaluation groups) you can only select pushbuttons 
using the mouse. 

 

Appearance and Labeling of the Pushbuttons: 
The pushbuttons are displayed using icons. Modifying the configuration allows a different icon to be 
displayed  

 

Configuring the Pushbuttons in Screen Forms: 
Every screen form has specific functions for the pushbuttons that must be available, e.g. the �OK� function 
to display values. It is possible to configure which pushbuttons and functions are available in each screen 
form. 

 

The following list contains all the available functions with the supplied icons. You can overwrite the icons with 
plant-specific ones. 
 

Icon Label Function 

 

OK Saves changes. 

 

Discard changes Discards changes and displays the screen with 
the original data. 

 

Main 
Screen 

Returns you to the main screen 
 

 

Back one 
Screen 

Goes back to the previous screen. 
 

 

Select all Selects all options 

 

Delete section Deletes the selected section in the current 
selection window 

 

Delete filter section Deletes filter section in the current evaluation filter
 

 

Delete filter Deletes the current evaluation filter 

 

Evaluation  
group 

Definition of evaluation groups 

 

Print screen form Displays print dialog 
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Current alarms Displays the current alarms screen 

  

Log Screen for displaying alarm logs for individual 
machines 

  

Statistics Screen for displaying alarm statistics for individual 
machines 

 

Current alarms 
eval. grp. 

Screen displays the current alarms of an 
evaluation group 

 

Log 
eval. grp. 

Screen for displaying alarm logs for individual 
machines 

 

Statistics 
eval. grp. 

Screen for displaying alarm statistics for individual 
machines. 

 

Alarm filter 
definitions 

Screen for creating and displaying evaluation 
filters 

 

Login Displays login screen to switch user authorization 

 

Help texts Displays the online help 
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3.5 Starting without Login 

By means of configuration, you can set up the user interface such that it starts without your needing to log 
in.  

By making the following entries in 
   General settings > ALARM_GUI 
You can specify whether the system is to display the login screen at start-up or what user to choose by 
automatic login: 

• LOGIN_ACTIV    0       - No login screen is displayed at start-up 
     1       - Login screen is displayed at start-up 

• LOGIN_CLASS  User class that is used if the system starts up without a login screen. 
    This entry is only used if the parameter "LOGIN_ACTIV = 0" is set. 

• START_MASK  This entry specifies what mask is displayed first (after the login) when 
     starting the user interface. 

Even if you started the user interface without a login screen, it is possible to log in under another user 
class at any time by selecting "File > Login screen" or the �Login screen� pushbutton. When you have 
done this, the system uses the settings and authorizations of this user class. 

 

 

 
3.6 Language Selection 

The texts of the screen forms can be displayed in various languages.  

You change languages using the "Options > Language" menu item. 

 

 

 
3.7 About 

The "Help > About" menu item displays a window containing the version number of the user interface. 

 

 

 
3.8 Display Help 

Calls the user interface's help screen. 
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4 Defining Evaluation Filters 

4.1 Defining Evaluation Filters 

 Activation Text Icon 

! Button Alarm filter definitions 

 

! Toolbar   

! Menu bar Evaluations > Alarm filter  

 

This screen form allows the user to create, modify or delete evaluation filters for alarm logs and statistics. 
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Default Setting of the Screen Form: 
The following values are set as a default when the screen form is displayed: 

• Filter name:  
The default evaluation filter configured. If no filter has been defined, the field remains empty. 

• Total duration:  
Value from the filter definition. If no filter has been defined, the field remains empty. 

• Working time duration:  
Value from the filter definition. If no filter has been defined, the field remains empty. 

• Minimum frequency:  
Value from the filter definition. If no filter has been defined, the field remains empty. 

• Sorting:  
Sorting order for the filter. If no filter is defined, then the alarm number is the default sorting 
criterion. 

• Alarm text:  
Value from the filter definition. If no filter has been defined, the field remains empty. 

�Filters for number ranges� tab: 
• Alarm group:  

First alarm group of the displayed filter definition. In no filter is defined, the first defined alarm 
group is the default. 

• Alarm number list:  
List with number ranges for the current filter. If no filter has been defined, the field remains empty. 

• Input line for list:  
Data from the first list line 

�Filters for alarm parameters� tab: 
• Default for the selection of alarms by alarm parameter values. Parameters which do not have a  

default are assigned �*�. 

 
Meanings of the Individual Screen Form Fields: 

• Filter name:  
Name of the evaluation filter. The filter is written to the database with this user-defined name. The 
filter can also be used with this name on separate screen forms. All previously defined filters are 
displayed in the selection list. 
You can modify or delete a filter after selecting it. To create a new filter, enter the name of the new 
filter in this field. 

• Total duration: 
You can invoke a filter based on the minimum duration of an alarm. Only those alarms are 
displayed in the log and statistics screen forms whose total duration are at least equal to the entry 
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in this field.  
If the field is left empty, then there is no filter applied for minimum duration. 

• Working time duration: 
You can apply a filter based on the minimum working time duration of an alarm. Otherwise, the 
same conditions apply as described in �Total duration�. 

• Minimum frequency: 
Only those alarms are displayed in the alarm statistics which have occurred as frequently as 
specified here for the period selected.  
If the field is left empty, then there is no filter applied for minimum frequency. 

• Sorting:  
Sorting order for the filter. In order to specify a sorting criterion for the current filter, choose one of 
the following criteria from the selection list: 
  Alarm number 
  Length of alarm 
  Alarm start time 
  Frequency of alarms 

• Alarm text: 
Each alarm is assigned an alarm text. You can enter a filter in the alarm text field. While filtering for 
text strings, wildcards may be used in the input field.  The wildcard symbol is �*�. 
Example: In order to return all alarms containing the word �alarm�, enter the string �*alarm*� in the 
filter field. 

 
�Filters for number ranges� tab: 

• Alarm group: 
A number range can be defined for each alarm group whose alarms are to be displayed or 
excluded.  
If no number ranges are defined in the table, then all alarm number instances are displayed in the 
evaluation screen forms. 
All existing alarm groups are displayed in the �Alarm group� selection list. 

• Alarm number table: 
This list displays the number ranges.  
Contents of the list: 
  Source:   Contains the source of the alarm 
  Starting with number: Start of the selected number range. 
  Ending with number: End of the selected number range. 
  Display:  Indication whether the number range is to be displayed or 
      excluded 
  Comment:  The comment is written to the database, but has no 
      effect on the use of the filter. 
The list is only for output and cannot have any data added or modified. It only allows individual 
rows to be selected. 

• Entry line for the list: 
The input line of the list displays the data from the table row currently selected and is editable.  
If the last (empty) row of the table is selected, then you can create a new row in the table.  

 
�Filters for alarm parameters� tab: 

• Parameter 1.. 8: 
The alarm messages can have up to eight parameters which can be inserted into the alarm 
message. These parameter field allow the alarms to be selected by a parameter value.  
 

 
Operator Inputs in the Screen Form 
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Creating a new Filter Definition: 
You can create a new filter by entering a new filter name in the �Filter Name� field. After entering further 
data, press �Apply filters�  to save them to the database. 

 
Modifying a Filter Definition: 
To modify filter data, select the filter to be modified in the �Filter Name� field. Enter the data to be modified 
and press �Apply filter� to save your work. 
As soon as you have made the first changes in the screen form, it is no longer possible to select a new 
filter. If you do not want to apply the changes, or if you want to modify a different filter, press �Discard 
changes� to revert to the earlier version. 

 
Deleting a Complete Filter: 
By pressing the �Delete filter�  button, you can delete the filter from the database. Discarding or 
modifying is no longer possible after selecting this function, i.e. the filter can not be recovered. 

 
Adding Number Ranges:  
An evaluation filter can contain several numbers and/or number ranges which may be used when filtering 
data. 
To add a new number range, select the last row in the output table. This row is empty. Enter the desired 
data in the input line below the table. Be aware of the following: Source: 
This field can only have one of the values from the selection list entered. 

• Source: 
Choose a value from the list. 

• Starting with number: 
Enter the lowest value of the desired number range. If you want to filter for a certain number, enter 
this number here. 

• Ending with number: 
Enter the highest value of the desired number range. If you want to filter for a certain number, 
enter this number here. 

• Display: 
Here you can select whether the number range chosen is to be displayed (�Yes�) or whether alarm 
numbers within the number range are to be suppressed. 

• Comment: 
You can take notes as a comment entry here. The comment is saved to the database, but is 
disregarded during evaluation for alarm logs and alarm statistics. 
 

 
Filtering Features for Alarm Parameters: 
You can select alarm parameters by individual values or by using wildcards. The following applies: 
  �*� and �%� stand for any number of characters. 
  �?� stand for any single character. 
The � and � characters are not allowed in the parameter field. 

Press the �Apply filter�    button to transfer the data to the database. 

 
Changing Number Ranges:  
To modify an entry in the number range table, click the appropriate line in the table. The data is 
transferred to the input line below the table. You can edit the data there. 
Press the �Apply filter�  button to transfer the data to the database. 

 
Deleting Number Ranges: 
To delete an entry in the number range table, click the appropriate line in the table   
Press the �Delete row�    button to delete the row from the table.  
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However, the data is still in the database.  
Pressing the �Apply filter�  will permanently delete the data in the database. 
 

If any changes have been made in the screen form, then you can only exit the screen form after the data 
has been written to the database  , or when all changes have been discarded . 

 

Printing out the Log Data / Creating an Export File: 

Press the �Print�    button to make a screen shot and a list of the data contained in the table as well as 
to export to Excel. 

For a description of the various print parameters, see �Printing Tables / Exporting Data to Excel� on page 
1-5. 
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5 Evaluations for Individual Machines 

5.1 Current Alarms 

 Activation Text Icon 

! Button Current alarms 

 

! Toolbar  
 

! Menu bar Evaluations > Current alarms  

 

This screen allows you to display the current non-reset alarms for individual machines and units. 

 

 
 

Default Setting of the Screen Form: 
The following values are set as a default when the screen form is displayed: 

• Plant, machine, unit:  
Pre-configured machine and unit. If no values are pre-configured, then Plant is given the value of 
the first plant in the work center master data (alphabetically) and Machine and Unit are given the 
�*� value.  

• List of alarms:  
The list is empty. 

 

Operator Inputs in the Screen Form: 
Using the selection lists �Plant�, �Machine� and �Unit� you can switch to another machine or another unit. 
You can also select �*� for �Machine� and �Unit�. In this case all plant log data for all machines or units are 
displayed. 

After selecting the machine(s) of your choice, press �OK� to display the current non-reset alarms from the 
table. 
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Contents of the Table: 
You can scroll either horizontally or vertically, as required. 

If you select a different machine, the table is deleted. Press �OK� or Return to generate the table with the 
current data specified. 

 
Updating Data: 
The data in the table is not automatically updated. To view the most current data, you must first press 
�OK�   

 
Printing out the Log Data / Creating an Export File: 

Press the �Print�  button to make a screen shot and a list of the data contained in the table as well as to 
export to Excel. 

 
For a description of the various print parameters, see �Printing Tables / Exporting Data to Excel� on page 
1-5. 
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5.2 Alarm Log 

 Activation Text Icon 

! Button Log 

 

! Toolbar   

! Menu bar Evaluations > Alarm log  

 

This screen allows you to display the contents of the alarm log for individual machines and units. 

 

 
 

Default Setting of the Screen Form: 
The following values are set as a default when the screen form is displayed: 

• Plant, machine, unit:  
Pre-configured machine and unit. If no values are pre-configured, then Plant is given the value of 
the first plant in the work center master data (alphabetically) and Machine and Unit are given the 
�*� value.  

• Period:  
When the screen form is first displayed after starting the program, the time period is for the current 
date, otherwise it is for the period last selected. 
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• Definition:  
When the screen form is first displayed, the standard filter configured is displayed�otherwise �*� is 
displayed. 
When the screen form is displayed a second time, the most recently selected evaluation filter is 
displayed.  

• Log data list:  
The list is empty. 

 

Operator Inputs in the Screen Form: 
Using the selection lists �Plant�, �Machine� and �Unit� you can switch to another machine or another unit. 
You can also select �*� for �Machine� and �Unit�. In this case all plant log data for all machines or units are 
displayed. 

In the "Definition� field, a previously defined selection filter can be entered by using a selection list. Only 
the data from the log is returned which matches the selection filter conditions. If the �Definition� field 
contains the value �*�, then no selection filter is applied. 

For a description of the various date field inputs, see �Operator Inputs to Screen Forms� on page 1-3. 

After selecting the machine(s) and time period(s) of your choice as well as any evaluation filter possibly 
needed, press �OK�    to display the log data in the table. 
Depending on the size of the log, this may take a number of seconds. 

 
Contents of the Table: 
The table will display the alarm log data which matches the selection criteria. You can also use the 
selection filter to sort the data. 
You can scroll either horizontally or vertically, as required. 

If you select a different machine or change the time period, the table is deleted. Press �OK� or Return to 
generate the table with the current data specified. 

 
Updating Data: 
The data in the table is not automatically updated. To view the most current data, you must first press 
�OK� . 

 
Printing out the Log Data / Creating an Export File: 

Press the �Print�  button to make a screen shot and a list of the data contained in the table as well as to 
export to Excel. 

For a description of the various print parameters, see �Printing Tables / Exporting Data to Excel� on page 
1-5. 
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5.3 Alarm Statistics 

 Activation Text Icon 

! Button Statistics 

 

! Toolbar  
 

! Menu bar Evaluations > Alarm statistics  

 

This screen allows you to display the contents of the alarm log for individual machines and units. 

 

 
 

 

Default Setting of the Screen Form: 
The following values are set as a default when the screen form is displayed: 

• Plant, machine, unit:  
Pre-configured machine and unit. If no values are pre-configured, then Plant is given the value of 
the first plant in the work center master data (alphabetically) and Machine and Unit are given the 
�*� value.  

• Period:  
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When the screen form is first called after starting the program, �Shift� is displayed, otherwise the 
period last selected is displayed. 

• Definition:  
When the screen form is first displayed, the standard filter configured is displayed�otherwise �*� is 
displayed. 
When the screen form is displayed a second time, the most recently selected evaluation filter is 
displayed.  

• List of statistical data:  
The list is empty. 

 

Operator Inputs in the Screen Form: 
Using the selection lists �Plant�, �Machine� and �Unit� you can switch to another machine or another unit. 
You can also select �*� for �Machine� and �Unit�. In this case all plant log data for all machines or units are 
displayed. 

In the �Definition� field, a previously defined selection filter can be entered by using a selection list. Only 
the data from the statistics is returned which matches the selection filter conditions. If the �Definition� field 
contains the value �*�, then no selection filter is applied. 

 
Time Types: 
The alarm statistics are saved at various compression levels. 

• �Shift�  - Compression of shifts 
For each shift, the overall time balance for alarms by unit and alarm number is displayed. 

• �Day� - Compression of days 
For each day, the overall time balance for the alarms by unit and alarm number is displayed. 

• �Week�  - Compression of weeks 
For each week, the overall time balance for alarms by unit and alarm number is displayed. 

• �Month� - Compression of months 
For each month, the overall time balance for alarms by unit and alarm number is displayed. 

• �Year� - Compression of years 
For each year, the overall time balance for alarms by unit and alarm number is displayed. 

You can choose an area to be compressed (�Shift�, �Day�, �Week�, �Month�, �Year�) from the �Period� 
selection list. 

 
For a description of the various date field inputs, see �Operator Inputs to Screen Forms� on page 1-3. 

 

After selecting the machine(s) and time period(s) of your choice, as well as any evaluation filter possibly 
needed, press �OK�    to display the log data in the table. 

Depending on the volume of statistical data, this may take a number of seconds. 

 
Contents of the Table: 
The table will display the various statistical table data which matches the selection criteria. You can also 
use the selection filter to sort the data. 

The table does not contain every single alarm, but instead the overall time and the frequency within the 
compression period selected. 

You can scroll in the table either horizontally or vertically, as required. 

If you select a different machine or change the time period, the table is deleted. Press �OK�  or Return 
to generate the table with the current data specified. 
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Updating Data: 

The data in the table is not automatically updated. To view the most current data, you must press �OK�  
again. 

 

Printing out the Log Data / Creating an Export File: 

Press the �Print�  button to make a screen shot and a list of the data contained in the table as well as to 
export to Excel. 

For a description of the various print parameters, see �Printing Tables / Exporting Data to Excel� on page 
1-5. 
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6 Evaluations for Evaluation Groups 

6.1 Defining Evaluation Groups 

 Activation Text Icon 

! Button Evaluation  
group  

! Toolbar   

! Menu bar Evaluations > Evaluation groups  

 

Machines and units can be combined in evaluation groups for the purpose of evaluation.  

 

 
 

Screen Presettings: 
When it is displayed the screen contains the following values: 

• Name of evaluation group: currently used evaluation group 

• List of machines and units:  
All defined machines and units.  
Machines/units belonging to the evaluation group have a check mark. 
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Screen operations: 
If the number of machines/units for an evaluation group is modified, the screen cannot be exited or 
another evaluation group selected until the changes have been saved by pressing �OK� or discarded by 
pressing �Cancel�. 

Individual machines/units can be selected/deselected in the list as follows: 

! By clicking the mouse on the box to the left of the machines/units. 

! By clicking on the line containing the currently selected machine/unit. 

! By selecting a machine/unit by clicking on it using the mouse or using the �up�/�down� cursor keys  
and pressing the space bar. 

! Not on Windows PC: The tick next to the currently selected machine/unit in the list is 
 enabled/removed by clicking on the �Select Line� button. 

By clicking on the Toggle button. On the SINUMERIK the key is in the center of the cursor keys, and on 
the PC it is in the center of the numeric keypad (key �5�, with NUMLOCK off). 
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6.2 Current Alarms for Evaluation Groups 

 Activation Text Icon 

! Button Current alarms  
eval. grp.  

! Toolbar   

! Menu bar Evaluations > Current alarms for evaluation groups  

 

This screen allows you to display the current non-reset alarms for evaluation groups. 
 

 
 

Default Setting of the Screen Form: 
The following values are set as a default when the screen form is displayed: 

• Group:  
Preset evaluation groups 

• List of alarms:  
The list is empty. 

 

Operator Inputs in the Screen Form: 
Using the selection list �Group�, you can switch to another evaluation group. 

Press the �OK� button to save the current non-reset alarms in the table. 

   
  ©  Siemens AG 2000-2003 All Rights Reserved 6-3 



Alarm and Message Evaluations MDA Machine/Cell/Plant 

 
Contents of the Table: 
You can scroll either horizontally or vertically, as required. 

If you select a different evaluation group, the table is deleted. Press �OK� or Return to generate the table 
with the current default data specified. 

 
Updating Data: 

The data in the table is not automatically updated. To view the most current data, you must press �OK�  
again. 

 

 
Printing out the Log Data / Creating an Export File: 

Press the �Print�    button to make a screen shot and a list of the data contained in the table as well as 
to export to Excel. 

For a description of the various print parameters, see �Printing Tables / Exporting Data to Excel� on page 
1-5. 
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6.3 Alarm Log for Evaluation Groups 

 Activation Text Icon 

! Button 

 

Log 
eval. grp.  

! Toolbar  
 

! Menu bar Evaluations > Alarm log for evaluation groups  

 

This screen form displays the alarms with start and finish times for units of an evaluation group over a 
user-defined period. 

 

 
 

Default Setting of the Screen Form: 
The following values are set as a default when the screen form is displayed: 

• Group:  
The evaluation group currently being used 

• Period:  
When the screen form is first displayed after starting the program, the time period is for the current 
date, otherwise it is for the period last selected. 

• Definition:  
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When the screen form is first displayed, the standard filter configured is displayed�otherwise �*� is 
displayed. 
When the screen form is displayed a second time, the most recently selected evaluation filter is 
displayed.  

• Log data list:  
The list is empty. 

 

Operator Inputs in the Screen Form: 
In the screen form, you can  
- Use the selection lists to choose an evaluation group and a evaluation filter and 
- Specify a time period.  

For a description of the various date field inputs, see �Operator Inputs to Screen Forms� on page 1-3. 

After selecting the evaluation group and period of your choice as well as any evaluation filter possibly 
needed, click �OK�    to display the log data in the table. 

Depending on the size of the log, this may take a number of seconds. 

 
Contents of the Table: 
The table will display the alarm log data which matches the selection criteria. You can also use the 
selection filter to sort the data. 
You can scroll either horizontally or vertically, as required. 

If you select a different machine group or change the time period, the table is deleted. Press �OK� to 
generate the table with the current default data specified. 

 
Updating Data: 

The data in the table is not automatically updated. To view the most current data, you must press �OK�  
again. 

 
Printing out the Log Data / Creating an Export File: 

Press the �Print�    button to make a screen shot and a list of the data contained in the table as well as 
to export to Excel. 

For a description of the various print parameters, see �Printing Tables / Exporting Data to Excel� on page 
1-5. 
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6.4 Alarm Statistics for Evaluation Groups 

 Activation Text Icon 

! Button Statistics 
eval. grp. 

 
 

! Toolbar  
 

! Menu bar Evaluations > Alarm statistics for evaluation groups  

 

This screen allows you to display the contents of the alarm statistics for individual machines and units. 

 

 
 

Default Setting of the Screen Form: 
The following values are set as a default when the screen form is displayed: 

• Group:  
The evaluation group currently being used 

• Period:  
When the screen form is first called after starting the program, �Shift� is displayed, otherwise the 
period last selected is displayed. 

• Definition:  
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When the screen form is first displayed, the standard filter configured is displayed�otherwise �*� is 
displayed. 
When the screen form is displayed a second time, the most recently selected evaluation filter is 
displayed.  

• List of statistical data:  
The list is empty. 

 
Operator Inputs in the Screen Form: 
In the screen form, you can  
- Use the selection lists to choose an evaluation group and an evaluation filter and 
- Specify a time period.  

 

Time Types: 
The alarm statistics are saved at various compression levels. 

• �Shift�  - Compression of shifts 
For each shift, a time balance for alarms for each unit and alarm number is displayed. 

• �Day� - Compression of days 
For each day, a time balance of alarms by unit and alarm number is displayed. 

• �Week�  - Compression of weeks 
For each week, a time balance of alarms by unit and alarm is displayed. 

• �Month� - Compression of months 
For each month, a time balance of alarms by unit and alarm number is displayed. 

• �Year� - Compression of years 
For each year, a time balance of alarms by unit and alarm number is displayed. 

You can choose an area to be compressed (�Shift�, �Day�, �Week�, �Month�, �Year�) from the �Period� 
selection list. 
 

For a description of the various date field inputs, see �Operator Inputs to Screen Forms� on page 1-3. 
 

After selecting the machine(s) and time period(s) of your choice as well as any evaluation filter possibly 
needed, press �OK�    to display the log data from the table. 

Depending on the volume of statistical data, this may take a number of seconds. 

 
Contents of the Table: 
The table will display the various statistics table data matching the selection criteria. You can also use the 
selection filter to sort the data. 

The table now no longer contains every single alarm, but instead displays the total duration and frequency 
for the compression period selected, broken down by each unit from the selected machine group. 

You can scroll in the table either horizontally or vertically, as required. 

If you select a different machine group or change the time period, the table is deleted. Press �OK� or 
Return to generate the table with the current default data specified. 

 

Updating Data: 

The data in the table is not automatically updated. To view the most current data, you must press �OK�  
again. 
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Printing out the Log Data / Creating an Export File: 

Press the �Print�    button to make a screen shot and a list of the data contained in the table as well as 
to export to Excel. 

For a description of the various print parameters, see �Printing Tables / Exporting Data to Excel� on page 
1-5. 
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7 Glossary 

Alarm 

Alarms and messages are disturbances or operation statuses reported by the machines. They are logged 
in the database and compressed to statistics. 

Configuration 

All the settings are stored in a configuration database and can be customized by means of the 
configuration interface. 

Evaluation filter 

To evaluate certain alarms, a filter can be created for the evaluation definition. Applying this filter allows 
you to have alarms evaluated by "minimum duration", "minimum frequency" and/or by certain number 
ranges. You can also specify the sorting order and filter by plain text strings. 

Hardcopy 

A printout of the current contents of the screen. 

Log 

The "Alarm log" contains the alarms and messages with their start and end times. 

Main screen 

A screen form from which you can go to all the other screen forms. The main screen does not include any 
functions. 

MDA 

Short-cut for "Machine Data Acquisition" . 

Menu bar 

The menu bar at the top of the window provides all the functions of the user interface. 

Message line 

The message line is at the bottom edge of the screen form.  

The background color shows the type of message:  
 Green - Information  
 Yellow - User error, warnings 
 Red - System error, serious error. There is usually more information in the system logbook. 

Pushbutton 

The system displays pushbuttons in the footer of screen forms or in the button bar below the menu items. 
You activate pushbuttons using either the function keys or the mouse. 

Start screen 

The screen form that is displayed after start-up or directly after the login screen in cases where login is 
required. You can change the start screen during configuration. 

Time types 

The time types in the alarm statistics are "Shift", "Day", "Week", "Month" and "Year". Condensed data is 
displayed for these time types. 
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User group 

The user group specifies which screen forms and functions are available to users. User groups are 
managed using the configuration interface. You can change the user group by means of the login screen. 
 
 

    
 7-2 ©  Siemens AG 2000-2003 All Rights Reserved 



MDA Machine/Cell/Plant Alarm and Message Evaluations 

8 Index 

A 
Alarm log 1-1, 1-3, 3-2�3-4, 3-6, 5-3, 6-5 
Alarm statistics 1-1, 1-3, 3-2�3-3, 3-6, 5-5, 6-7 
Authorization groups 1-1 

D 
Date and time inputs 1-3 

F 
footer 1-3, 3-1�3-2 

H 
help system 2-1 

K 
Keyboard inputs 1-3 

L 
Language selection 3-7 

M 
main screen 3-1, 3-3, 3-5 
Making printouts 1-5, 4-5, 5-2, 5-4, 5-7, 6-4, 6-6, 

6-9 
menu bar 2-1, 3-1�3-3 
Menüleiste 6-1, 6-3, 6-7 

S 
start screen 3-1 
Starting without login 3-7 
Symbolleiste 6-1, 6-3, 6-5, 6-7 

T 
time types 1-3, 5-6, 6-8 

V 
version number 3-2, 3-7 
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